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EXCEL 

Excel is spreadsheet software that comes with powerful tools and features which enable us to manipulate, analyze, calculate data in 
desired manner. 
Spreadsheet – It is a large sheet containing rows and columns arranged in the form of matrix. 

HOW TO OPEN MS. EXCEL 

1) Method 1 
a. Click on start button 
b. Click on all programs 
c. Click on MS – office 
d. Click on excel 

2) Method 2 
a. Click on start 
b. Click on Run  
c. Type excel on Name box 
d. Click on ok button 

3) Method 3 
a. Right click on blank space of desktop or any folder 
b. Go to new 
c. Click on MS excel worksheet 
d. Type the name of file 
e. Press enter 
f. Right click on it and open it. 

INTRODUCTION TO EXCEL SCREEN 

 
Name  Description 
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Active cell indicator  this dark outline indicates the currently active cell (one of the 17,179,869,184 cells on 
each worksheet). 

Collapse the Ribbon Button  Click this button to temporarily hide the Ribbon. Click it again to Make the Ribbon 
remain visible. 

Column letters  Letters range from A to XFD — one for each of the 16,384 columns in the worksheet. You 
can click a column heading to select an entire column of cells or drag a column border to 
change its width. 

File tab  Click this button to open Backstage view, which contains many options for working with 
your document (including printing) and setting Excel options. 

Formula bar  When you enter information or formulas into a cell, it appears in this bar. 
Help button  Click this button to display the Excel Help system window. 
Horizontal scroll bar  Use this tool to scroll the sheet horizontally. 
Macro recorder indicator  Click to start recording a VBA macro. The icon changes while your actions are being 

recorded. Click again to stop recording. Name box This box displays the active cell 
address or the name of the selected cell, range, or object.] 

New sheet button  Add a new worksheet by clicking the New sheet button (which is displayed after the last 
sheet tab). 

Page View buttons  Click these buttons to change the way the worksheet is displayed. 
Quick Access Toolbar  This customizable toolbar holds commonly used commands. The Quick Access Toolbar is 

always visible, regardless of which tab is selected. 
Ribbon  This is the main location for Excel commands. Clicking an item in the tab list changes the 

Ribbon that is displayed. Ribbon Display Options A drop-down control that offers three 
options related to displaying the Ribbon. 

Row numbers  Numbers range from 1 to 1,048,576 — one for each row in the worksheet. You can click 
a row number to select an entire row of cells. 

Sheet tabs  Each of these notebook-like tabs represents a different sheet in the workbook. A 
workbook can have any number of sheets, and each sheet has its name displayed in a 
sheet tab. Sheet tab scroll buttons Use these buttons to scroll the sheet tabs to display 
tabs that aren’t visible. You can also right-click to get a list of sheets. 

Status bar  This bar displays various messages, as well as the status of the Num Lock, Caps Lock, and 
Scroll Lock keys on your keyboard. It also shows summary information about the range 
of cells selected. Right-click the status bar to change the information displayed. Tabs 
Click these tabs to display different Ribbon commands, similar to a menu. 

Title bar  This displays the name of the program and the name of the current workbook. It also by 
default holds the Quick Access Toolbar (on the left) and some control buttons that you 
can use to modify the window (on the right). 

Vertical scroll bar  Use this to scroll the sheet vertically. 
Window Close button  Click this button to close the active workbook window.  
Window Maximize/Restore button  Click this button to increase the workbook window’s size to fi ll the entire screen. If the 

window is already maximized, clicking this button returns Excel’s window to its prior 
size so that it no longer fi lls the entire screen. 

Window Minimize button Click this button to minimize the workbook window. The window displays as an icon in 
the Windows taskbar. 

Zoom control  Use this to zoom your worksheet in and out. 
 

RIBBON TABS 

 
The commands available in the Ribbon vary, depending upon which tab is selected. The Ribbon is arranged into groups of related 
commands. Here’s a quick overview of Excel’s tabs: 
 

 Home: You’ll probably spend most of your time with the Home tab selected. This tab contains the basic Clipboard commands, 
formatting commands, style commands, and commands to insert and delete rows or columns, plus an assortment of worksheet 
editing commands. 

 Insert: Select this tab when you need to insert something in a worksheet — a table, a diagram, a chart, a symbol, and so on. 
 Page Layout: This tab contains commands that affect the overall appearance of your worksheet, including some settings that 

deal with printing. 
 Formulas: Use this tab to insert a formula, name a cell or a range, access the formula auditing tools, or control how Excel 

performs calculations. 
 Data: Excel’s data-related commands are on this tab, including data validation commands.  
 Review: This tab contains tools to check spelling, translate words, add comments, or protect sheets. 
 View: The View tab contains commands that control various aspects of how a sheet is viewed. Some commands on this tab are 

also available in the status bar.  
 

WORKBOOK AND WORKSHEET  
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The file of excel is known as work Book. Every Pages of workbook is called worksheet. By default a workbook has three sheets named as 
Sheet1, Sheet2, and Sheet3. The file extension of workbook is .xlsx. A work sheet contains 16384 columns (named as A, B….AA, 
AB……XFD) and 1048567 Rows (Named as 1, 2, 3……) 

 Note – The file extension of  earlier version from 2007 is .xls 

ABOUT CELLS 

Excel stores all the information in the cells. A cell contains 32767 characters on it. Before going through data entering in cell, it is ensure 
that you have knowledge of data types that can be stored in a cell. 
A cell contains three types of data 

1) Text 
2) Number 
3) Formulas 

Note- A worksheet contains charts, Shapes etc. 

NAVIGATION THROUGH WORKSHEET 

Key  Action 

Up Arrow Moves the active cell up one row 

Down Arrow Moves the active cell down one row 

Left Arrow or Shift+Tab Moves the active cell one column to the left 

Right Arrow or Tab Moves the active cell one column to the right 

Page Up Moves the active cell up one screen 

Page Down Moves the active cell down one screen 

Alt+Page Down Moves the active cell right one screen 

Alt+Page Up Moves the active cell left one screen 

Ctrl+Backspace Scrolls the screen so that the active cell is visible 

Ctrl+End Moves the active cell to the intersection of the row with the 
lowermost entry (highest row number) on the worksheet and the 
column with the rightmost entry (highest column letter) on the 
worksheet 

Up Arrow  Scrolls the screen up one row (active cell does not change)  

Down Arrow Scrolls the screen down one row (active cell does not change) 

Left Arrow Scrolls the screen left one column (active cell does not change) 

Right Arrow Scrolls the screen right one column (active cell does not change 

 

WORKING ON CELLS 

 Entering Data into cells 
a. Place the cell pointer in the desired cell. 
b. Type the information the cell 

 Editing Data into cells 
a. Place the cell pointer in the desired cell. 
b. Double Click on the cell or Press F2 Button 
c. And edit the information  

 Deleting data of a cell 
a. Place the cell pointer in the desired cell 
b. Press delete button 

 Selecting Cells 
a. Click on the a cell and Drag over the cells 
b. Place the  cell pointer on the desirer cell and hold the shift key and use arrow key s to select the cells 

 Copying and moving cells data  
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a. Select the cell or group of cells (range ) 
b. Press ctrl +c to copy the cells or press ctrl+x to move the data . 
c. Select cells where the data is going to be copied or moved. 
d. Press ctrl+v 

 Drag and Drop method of copying and moving data. 
a. Select the cell or group of cells(Range) 
b. Move the mouse pointer on the border of the selection 
c. Hold Ctrl button if we want to copy the data, if you want to move the data then don’t hold he ctrl Bottom. 
d. And click the left button of the mouse and move the mouse pointer to the onother location of the spread sheet. 

FORMATTING OF CELLS 

 Formatting using font group 
a. Select the Cells whose formatting is to be formatted 

i. Click on the font face list box and select desired font to 
change the font face of the 
cell data. 

ii. Click on the size button to increase or decrease the cells 
data. 

size.  iii. Click Increase font size button to increase the size of increase of the font 

iv. Click decrease font size button to increase the size of increase of the font size.  

v. Click Bold button to bold the font.  

vi. Click Italic button to Italic the text.  

vii. Click under line button to under line the text.  

viii. Click the Border button to Giveborder to the cells.  

ix. Click fill cells button to fill the cell  

x. Click font color button to change the font of the text.  
xi. Formatting using Formate painter 

 Select the cells which formate is to be copied . 

 Click on fromate painter button on the clip board group in the Home tab.  
 Click the cell which formate is to be formated . 

 Formatting using Style Group 
1. Using Conditional formatting 

i. Conditional formatting enables us to change the formatting according the conditions.  
 There are Five types of conditional formatting 

a. Highlight Cell Rules: Examples include highlighting cells that are greater than 
aparticular value, between two values, contain specifi c text string, contain a date,or are 
duplicated. 

i. Greater than ten: Values greater than ten are highlighted with a 
differentbackground color. This rule is just one of many numeric-value-related 
rules thatyou can apply. 

ii. Above average: Values that are higher than the average value are highlighted. 
iii. Duplicate values: Values that appear in the range more than once are 

highlighted. 
iv. Words that contain X: If the cell contains X (upper- or lowercase), the cell 

ishighlighted. 
v. Data bars: Each cell displays a horizontal bar, the length of which is 

proportionalto its value. 
b. Top Bottom Rules: Examples include highlighting the top ten items, the items inThe 

bottom 20%, and items that are above average. 
c. Data Bars: Applies graphic bars directly in the cells, proportional to the cell’s value 
d. Color Scales: Applies background color, proportional to the cell’s value 
e. Icon Sets: Displays icons directly in the cells. The icons depend on the cell’s value. 
f. New Rule: Enables you to specify other conditional formatting rules, includingrules 

based on a logical formula 
g. Clear Rules: Deletes all the conditional formatting rules from the selected cells 
h. Manage Rules: Displays the Conditional Formatting Rules Manager dialog box, inwhich 

you create new conditional formatting rules, edit rules, or delete rules. 
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ii. Using Table as formatting 

iii. Using Cells style 
 

 
 

iv. Alignments of data on cells 
 On the Home tab, in the Alignment group, do one or more of the following:  
 To change the vertical alignment of cell 

contents, click Top Align , Middle Align , or 

Bottom Align .  
 To change the horizontal alignment of cell 

contents, click Align Text Left , Center , or 
Align Text Right .  

 To change the indentation of cell contents, click Decrease Indent or Increase Indent .  
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 To rotate the cell contents, click Orientation , and then select the rotation option that you want.  
 To wrap the text in a cell, click Wrap Text.  
 To use additional text alignment options, click the Dialog Box Launcher next to Alignment, and 

then on the Alignment tab of the Format Cells dialog box, select the options that you want. For 
example, to justify the text in a cell, on the Alignment tab, click the drop-down box under 
Horizontal, and then click Justify. 

WORKING ON LAYOUT OF WORKSHEET 

 Inserting of cell, rows, sheet, column  
a. Insert a cell 

i. Select the cell or the range  
ii. On the Home tab, in the Cells group, click the arrow next to Insert, and 

then click Insert Cells.  
iii. In the Insert dialog box, click the direction in which you want to shift the 

surrounding cells.  
b. Insert rows on a worksheet 

i. On the Home tab, in the Cells group, click the arrow next to Insert, and 
then click Insert Sheet Rows.  

c. Insert columns on a worksheet 
i. then click Insert Sheet Columns.  

 Delete cells, rows, or columns 
a. On the Home tab, in the Cells group, click the arrow next to Delete, and then do one of the following:  

 To delete selected cells, click Delete Cells.  
 To delete selected rows, click Delete Sheet Rows.  
 To delete selected columns, click Delete Sheet Columns.  
 Tip  You can right-click a selection of cells, click Delete, and then click the 

option that you want. You can also right-click a selection of rows or 
columns and then click Delete. 

 If you are deleting a cell or a range (range: Two or more cells on a sheet. 
The cells in a range can be adjacent or nonadjacent.) of cells, in the 
Delete dialog box, click Shift cells left, Shift cells up, Entire row, or Entire 
column.  

 If you are deleting rows or columns, other rows or columns 
automatically shift up or to the left. 

 Change the width of a Column and Height of Row 
a. Place the cursor,where you want to  Change the width of a Column and Height 

of Row. 
b. Goto insert tab, in cells group. 

c. Click Row Height to change height of row and Click 

Column widht to chnage the width of column.  
d. Write no on Row height or Colum width text box. 
e. And click on ok button. 

 

FINDING AND REPLACING DATA  

f. Finding data 
 Click on A1 cell 
 Go to Editing group of home tab. 
 Click on Find & Replace 
 And Click on Find. 



 

7 
 

7 

 Type the word you want to find in Find what text box. 
 And click on find Next Button 

g. Replace data 
 Click on A1 cell 
 Go to Editing group of home 

tab. 
 Click on Find & Replace 
 And Click on Replace. 
 Type the word you want to find 

in Find what text box. 
 Type word in replace with text 

box . 
 And click on find Next Button 
 After than click on Replace buton to replace selected data or 

Replace All to Replace all the data. 

USING CALCULATIONS FEATURE OF EXCEL 

h. Formula :- general equation to solved same type of mathematical 
functions. 

i. Types of formulas 
 Cell content base formulas 

 Exp : 
 Cell content address base formulas 

 Exp : 
j. Types of addressing :  

 There are three types of formula addressing. 
 Relative addressing 

Ex- = A1+B1 
 Absulate addressing or fixed addressing 

Ex- = $A$1+$B$1 
 Mixed addressing. 

Ex- = $A1+ B$A 
Range : A rectangular group of cell type of function. 
EX : B2:B10 
 
 

Mathematical function 
Sum()=For adding 
Ex≔sum(A1:B1) 

 
 
=101 

 
Product()=For multiplying 
Ex≔product(A1:B1) 
 

 
 
=2520 

Sqrt()=For square root. 
=sqrt(A1) 
 

 
 
=5 

Power()=For power 
=power(A1,2) 
 

 
 
=625 
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Int()=For deleting fractional part. 
=int(A1) 
 

 
=25 

Statics function 
Average() 
=Avereage(A1:F1) 
 

 
 
=5.5 

Count()=For counting 
=count(A1:E2) 
 

 
=5 

Max()=For maximum value 
=max(A1:F2) 
 

 
 
=99 

Min()=For minimum value 
=min(A1:F2) 
 

 
=1 

Median() 
=median(A1:F1) 
 

 
=39.5 

Mode 
=mode(A1:F1) 
 

 
=34 

Date and time function 
Days360() 
=days360(A1,B1) 
 

 
 
=5444 

Month() 
=month(A1) 
 
 

 
=1 

Year() 
=year(A1) 
 
 

 
 
=2014 

Now() 
=now() 
 

 
=current date and 
time display 

Minute() 
=minute(A1) 
 

 
=47 

Day() 
=day() 
 
 

 
=29 
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Today() 
=today() 
 

 
=current date 

Hour() 
=hour(A1) 
 

 
 
=2 

Second() 
=second(A1) 
 

 
=33 

Text function 
Concatenate () 
=CONCATENATE(A1,” “,B1,” “,C1) 
 

 
 
=Amit Kumar Kumbhkar 

Upper() 
=upper(A1) 
 

 
=AMIT 

Lower() 
=lower(A1) 
 

 
=amit 

Proper() 
=proper(A1) 
 
 

 
=Amit 

Right() 
=right(A1,8) 
 

 
=kumbhkar 

Left() 
=left(A1,4) 
 

 
=amit 

Mid() 
=mid(A1,6,5) 
 

 
 
=kumar 

Rept() 
=rept(A1,3) 

 
 
=AmitAmitAmit 

Logical function 
If(logic_test,value_if_true,value_if_false) 
=if(G2>265,”pass”,”fail”) 

 
=pass or fail 
 

Count if() 
=countif(A1:K1,”p”) 

 
=9 

    Trignomentric or data base function 



 

10 
 

10 

Lone 
a) L.A. 
b)intrest 
c)period 
d)installmant 
lone calculation a lone consisting following components 

i. The lone amount 
ii. Interest rate 

iii. Number of payment 
iv. Periods payment amount 

The PMT function 
 
The PMT function returns the loan payment per period. 
 PMT (RATE,NPER,PV,FV,TYPE) 
Rate The interest rate per period=/12 
Nperthe total number of payment period=*12 
Pvthis is the present value or the loan amount (-) 
Fvthis figure value after the last payment is made.(0) 
Typeincludes when payment are due either zero or one if you omit tab, it is assume to be zero. 
Example: 

 
The PPMT functions 

The PPMT funcation return the principal part of the loan, payment for the given period assuming constant payment amount and a fixed 
interest. 

PPMT(RATE,PER,NPER,PV,FV,TYPE)  

Example∷ 

The IPMT function 
The pv function return the present value for a lone. 
PVC(RATE, NPER, PMT, FV, TYPE) 

Example∷ 

 
  
FV(RATE, NPER, PMT, PV, TYPE) 
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Example∷ 

 
Pivot table 

A pivot table is essentially a dinemic summery report generated form can report form a data base . the data 
base can inside a work sheet in and external data file . A pivot table can help to transfer endless rule and 
column of numbers into meaningfull data. 

 

 

 

 

 

Filling serise: excle suppose a cell varidty of filling option. 
Goto home tabediting groupfill series. To display the series dialog box. 
Custom list:  

 1.to define your own list go to office button excel option popular tabedit custom list. 
 2.click on new list type the new list itemclick on add. 
Functions pre return formula are called function. 

CHARTS 

A chart is a graphical representation of numberic values. A chart is also known as graph. Excel chart features 
Provide a verity of chart including bar, column, area, line and many 
more.  

Types of chart 

1)Column charts in column charts, categories are typically organized along 
to emphasize the different between items. 

2)Line chartData that is arranged in columns or rows on a worksheet can be 
plotted in a line chart. Line charts can display continuous data over time, set 
against a common scale, and are therefore ideal for showing trends in data at 
equal intervals. In a line chart, category data is distributed evenly along the 
horizontal axis, and all value data is distributed evenly along the vertical axis.  

3) Pie charts Data that is arranged in one column or row only on a worksheet 
can be plotted in a pie chart. Pie charts show the size of items in one data series, 
proportional to the sum of the items. The data points in a pie chart are displayed 
as a percentage of the whole pie.  

4) Bar charts Data that is arranged in columns or rows on a worksheet can 
be plotted in a bar chart. Bar charts illustrate comparisons among individual 
items. 

5) Area chartsData that is arranged in columns or rows on a worksheet can 
be plotted in an area chart. Area charts emphasize the magnitude of change 
over time, and can be used to draw attention to the total value across a trend. 
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For example, data that represents profit over time can be plotted in an area chart to emphasize the total profit 

DATA VALIDATION  

Data validation is an Excel feature that you can use to define restrictions on what data can or should be entered in a cell. 
You can configure data validation to prevent users from entering data that is not valid. If you prefer, you can allow users to 
enter invalid data but warn them when they try to type it in the cell. You can also provide messages to define what input you 
expect for the cell, and instructions to help users correct any errors.For example, in a marketing workbook, you can set up 
acell to allow only account numbers that are exactly three characters long. When users select the cell, you can show them a 
message such as this one: 

To set validation into cell  

 Select the cell or range  

 Go to data tab  

 Click on data validation on the data tools groups  

 Click the setting tab set appropriate  criteria  

 Click the input message tab and specify which message to display when we select the cell (optional) 

 Click the error alert tab and specify which error message to display when we make and invalid input. 

 

DATA FORM 

Many user use excel to manage in which the information is arrange in rows .excel offer a simple way to work this type a data 
through a use of data entry form that excel can create automatically.  

 Click on the office button 
 Click on excel option 
 Goto  customizeribbon 
 Chooseall commands 
 choose the FORM options in drop down list 
 Click on add button 
 And click ok button 

FREEZE PANEL 

If you set up a worksheet with row or column heading these heading will not visible. When we scroll down or the right excel 
Provide the handy to this problem freezing panel.  

 Select the row of list 
 Gotoview tab  
 Click on freezing panel  
 select your option where you want to freeze the row and column. 

FILTERING OF DATA  

Select the data that you want to filter   
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1. On the Data tab, in the Sort & Filter group, click Filter.  

 

2. Click the arrow in the column header to display a list in which you can make filter 
choices.  

 

Filter by selecting values or searching   

3. Selecting values from a list and searching are the quickest ways to filter. 
When you click the arrow in a column that has filtering enabled, all values 
in that column appear in a list. 

 

Use the Search box to enter text or numbers on which to search 

Select and clear the check boxes to show values that are found in the column 
of data 

Use advanced criteria to find values that meet specific conditions 

 

1. To select by values, in the list, clear the (Select All) check box. This 
removes the check marks from all the check boxes. Then, select only the 
values you want to see, and click OK to see the results.  

2. To search on text in the column, enter text or numbers in the Search box. 
Optionally, you can use wildcard characters, such as the asterisk (*) or the 
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question mark (?). Press ENTER to see the results. 

SCENARIO MANAGER 

In that type of scenario or in your business and personal life, using templates offers the 
Following benefit to: 
■ The documents produced will be consistent, even when they are produced by different 
people. 
■ If the templates are carefully developed and reviewed, using them ensures that 
your documents will be complete with all the needed information, every time. 
■ Setting up templates with your company logo and contact information ensures that 
information will appear on every document you create, which helps with branding 
and promoting your organization. 
■ For longer documents like reports or newsletters, the benefit of using a template 
increases, because designing all the formatting in such documents can be time 
consuming.Take a look at the templates available to you via Word now. 
Scenario Summary   

    Current Values: System 

Name of 
Customer Product Quantity Price 

Totle 
price 

Changing 
Cells:     

Avinash Mouse 10 200 2000 

  $A$1 
Name of 
Customer 

Name of 
Customer 

Aman Monitor 18 7000 126000 

  $B$1 Product Product 
Abhishek Keyboard 24 250 6000 

  $C$1 Quantity Quantity 
Abhinav C.P.U 20 12000 240000 

  $D$1 Price Price 
Akshya U.P.S 9 700 6300 

INPUT 
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  $E$1 Totle price Totle price 
  $A$2 Avinash Avinash 
  $B$2 Mouse Mouse 
  $C$2 10 10 
  $D$2 200 200 
  $E$2 2000 2000 
  $A$3 Aman Aman 
  $B$3 Monitor Monitor 
  $C$3 18 18 
  $D$3 7000 7000 
  $E$3 126000 126000 
  $A$4 Abhishek Abhishek 
  $B$4 Keyboard Keyboard 
  $C$4 24 24 
  $D$4 250 250 
  $E$4 6000 6000 
  $A$5 Abhinav Abhinav 
  $B$5 C.P.U C.P.U 
  $C$5 20 20 
  $D$5 12000 12000 
  $E$5 240000 240000 
  $A$6 Akshya Akshya 
  $B$6 U.P.S U.P.S 
  $C$6 9 9 
  $D$6 700 700 
  $E$6 6300 6300 
        

 

GOAL SEEK 

 
It determines the value that you need to enter in a single input cell to produce a result that you want in a 
dependent (formula) cell. 

Place the cursor on cell . Choose DATADATA TOOLSWHAT-IF-ANALYSISGOAL SEEK.Excel display the 
goal seek dialog box. 

 

 

, 

ADDING A DATA TABLE 

Sometimes the chart tells the full story that you want to tell, but other times the audience may benefit from seeing the actual 
numbers on which you have built the chart. In these cases, it is a good idea to include the data table with the chart. A data 
table contains the same information that appears on the datasheet. 
To display the data table with a chart, click Chart Tools ➪ Design ➪ Chart Layouts ➪ Add Chart Element ➪ Data Table and 
choose to include a data table either with or without a legend key. 
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PROTECT THE EXCEL WORKBOOK 

To protect your Excel 2010 spreadsheet, use the following options. 

1. In an open spreadsheet, click the File tab. The Backstage view opens.  

2. In the Backstage view, click Info.  

3. In Permissions, click Protect Workbook. The following options appear: 

The following image is an example of the Protect Workbook options. 

 

 Mark as Final   Make the document read-only  

 Encrypt with Password  Set a password for the document  

 Protect Current Sheet  Protect the worksheet and locked cells  

 Protect Workbook Structure  Protect the structure of the worksheet  

 Restrict Permission by People   Install Window Rights Management to restrict permissions  

 Add a Digital Signature   Add a visible or invisible digital signature  

MICRO 

It is a advance feature that can speed up editing or formatting a excel document. If record sequence of menu selecting 
choose so that a series of action are completed in step one. Typical use of micro area. 

Recording a micro  
 Click the view tab. 
 Click the micro and click record micro group. 
 In the micro name box, type a name of micro. 
 Click on close button. 

For Stop recording 
 In the micro group click micro button and click stop recording. 

 

 

 


